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MAC
ADDRESS

POWER

=y

Atmark Techno,Inc.
Made in Japan

Atmark Techmo

5-1 MAC ZRLRREIE (RAEM)
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@ Ama—>F 7 ar>IPHREXRIRLET,

,:__ JB Manager
FrIEY O FED

y TE7720%— F{U
! ! INTH | E IPEAED

Ir—LUITPEERE

S=1E

)L ZHH?

e - -
Position | Device ID Device Mame
Titne Event

®5-2 IP&RERFDI1FD

® IPREFA TR I NAF—T LET,
@ HBMICHRR L, Xy T =27 NITF(ET D JTAG-Blazer 02 R L ET, £ HEMRKT D
B, MEBERZ L EI Y v LET,

X PRS0l W=l

MAC Address | IP Addres=s | Subnet Mazk | Detault G | DHCP |

| RS

K 5-3 IPREFA47OY
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® MERLI-MACT7 RLAREREINFETOT, BIRLTHLIPERERZ L E2 27U v/ LTLIEEN, £
7-. “IP Address” OHIZERINTWAT RL AR, BEREISNTWAIPT FLRERD £1,
HKBRBALTH, MBDOMAC 7 RLUANRFERINRWEGAIE, BEEGE R 230,

X IPSRELAFOY

MAC Address | IP Addres=s | Subnet Mazk | Detault G | DHCP |
Tadhn | 10016010034 D55 255 20h 1

e | e |

B 5-4 WEREDIPJ/EL1T7OT

©® WJEXATOTPNA—FENET,
DHCP #fiH 3 25A1%. “DHCP 2" #F7=v 7 LTOKARX %27 Y v 7 LTLTEEN,
DHCP %z L7anWiG&iE, “DHCP #/H” #RkF = v Z7IKEEIC L, HNOKEEZ AL OK A ¥
VEIZV w7 LTLTIEEN,

IPSRER MDY cdl BiEEERI VS
v DHCP#{#MR [ DHCP#{#ME
PFELZ | IPPELA |12 168 10 100
HIFubvRY | YiFwybvas | 65 66 26 0
3 | W F—Frz | 192 1a2 10 1
&tz &tz

5-5 IPEREFA47OY
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@D WEROLXATu I B"A =T IhET,

B &b rny”

IEEE G >TLET

B 5-6 EFEFI7OT

REDEENTET T DL, BIGTHRFERINET,

®5-7 BREREEFET AvE—o

.
VAN

IWBERHLEA T 0 I NERINTWAMIL.JTAG-Blazer DFE ﬁ%mg@wi\\
THELEE N,

IP
RKIPT RLVAFEEY—NLTIE, UTFOT7 RLAEZFRETHZ L2 IEL TV E
T, TR TSN,
-+ 0.0.0.0
- 255.255.255.255
T BE—RXY AT RLX
CINTFFXYART KA
« VI AET RL &
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5.2.1P

JB Manager 7° 5 JTAG-Blazer Z##/E3 5 & &%, IP 7 N L AR EMHEKIZ JTAG-Blazer D IP 7 KL &
AN LRT LR FE A, ANFEITIZUTO 2 5O HERH Y £,
EENT
[GEZRAA
ZOHETIE, HANDOTIEZOWTHA L LT,

'ﬁ‘ W, NN—ZEz2 BRI TEEFA, 7 — R v X b3y bAELS Xy b
U—JWNTHEHLTLIZEN,
VT 53y hU—ZIZBALTCIARHREN I NWELEZL, Xy hT—7 DE

PEA~THERSTE S0,

fi ,I_.ﬂr_ AREHEIX. JTAG-Blazer OfRFREIZT 2 — R¥¥ A h/ 37w ]\ig@iﬁﬁﬁbfpgﬂb\
-~

5.2.1.
PC & JTAG-Blazer % LAN |28t LE 7, BEFO Ry MU —7 20 S TIWCHEBEEGE T 25813, 71X
HATDOLAN 7 — 7 &2 FEH L TLEE N,

5.2.2.
O IPT7 FLVAfIGATIRZ 27 ) v 7 LET,

7.:__ JB Manager
FrULE) O RBEY AL FTOL ALTHH

,'f_-" I
j &H E E@PTH/Z%%%)UJ‘H‘!D

PPELR | pﬂpﬁ | | .
Position | Dewvice ID ICE MHame
Time Event

K 5-8 IP7FLABEEAABED IR
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@ FRENTEIPT RLRADOHPMNS, U THIPT FLRAZEZT ALY v 7 LTLIEEN,

MAG Address | IP Addresz | Subnet Mazk | Default G | DHGP |
wooooc 123456 19216810234 255 2552550 192168101 yes

1

E5-9 JBRELs7OY
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5.3.

AHEREIL. JTAG-Blazer |2t SN TCWA X —47 v hAR— R EDT A 2% Xy NU—I B Ta 7
4 FXa2lb—varlFEFT, a7 4Xalb—rarT—2OV A RHIBRITRL . HEDOT A 2% —FED
BECary 74 Xal—rard b2 ARETY,

5.3.1.

H—lFy NTNNA A a7 4 Xalb—vardbarZ7 s Fal—ralry7rANEREELET, 2
TAX2L— g T 7 AINVDIERFTIEIZ. M@&B.av 74 X¥al—Y a7 7 A MMERFIEl 23 B L
TLTEEW,

5.3.2.

PC & JTAG-Blazer # LAN (285t L £ 3, BEfFO Ry MU —27 20 STICEEER T 2581, 712 A
2A4TFDLAN #—7LVEFH LT &, JTAG-Blazer & % —#4 v hAR— Ri% [4.5JTAG 7 —7 D
B Al 22U, 8L T 7EE0,

Btk MR mE R 2T LTSS, (56 BERERFT] 22M) =7 —L o 581%, HE
Bt THERB S T2 S W,

5.3.3.

D JTAG-Blazer ®IP 7 KL ZZ AN LET, IP7 FLAREHEBICIP 7 FLAEZ AL TLEEW,

@ arv74Xal—rarI7ryANVERIRLET, 77 A VORI, 77 A VEIRRF L E2 7 ) w7 L
Ty ANEERT DD, 77 A NAREEIBICEIAL T 7 A VOt A B AT, £idar 7 ¥ =
L—y a7y ANVEBENLEIRL T EEN,

oS a7 4FXalb—var7 A0t SVFE, XSVF, JSVF #H%7AR— K Lfb\i\
;I'§‘ T, TIEI svi, xsvl, jsvf & WO IEET4 CTHIBIS v, LI OYEsET

IZOWTIE, SVEF 77 AL E LT EINET,

@ Z—H v NERALRZ L Z27 ) v 7 LET,

A—FyhERAHRIY —
A,‘ T T Fi7 e F':':.E:' #ji"ﬂ:—f{gl' ﬁm{‘i} M) L':?{H:'

AL IERLLEe

IPPELA | 192 1683 10 1 | e | |C:¥..lTF'.G—EIIazer¥sample.svf 1

Pogition | Device ID Device Name . ‘
0 01 41093 HCESA00 (774 ,LE*RM,)
Titme Event

E5-10 A—45YhEAABFEDI4VED
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@ FABFERT 4 RUNT =T SNET, FRABNTA—ZNIELNI L &R L, OK RF &7
Uy 7 LTLKEEN,

EiAD B2 X
FPELA 192168101

ACLO—=FA4T : Tarest

eIl : zamplesyi

e : 212792 bytes

w1 )R : Mo

i P WL F : Mohe

@ 30 A AR E T, LALL T 7

F+ 7l

B 5-11 A=Y EAHTER D14

® EEFA TR T NA—T L ENET, BELA T v 7IE, FALOEBRR P T RINET,
© FAAHT TR, WS AT 0 ZZHBIC n—X LT,

EEE{TOS X

Firde

B 5-12 EESF 47OY
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KT —0RELHE. A vE—URERIN, BERRERICT T —a— FRRRSNET,
HFLVWZI—ARIT, rRShicnd—a—Fx IfF&C I —U X ] THRLTIEZSN,

,:__ JB Manager

FrLEY O RE

IPFELA | 192 168 10

FFua0) FTA AJTHH

Pozition | Device ID

Titne | Everl

) 2005/01/24 20:11:24 THA AU A ERR

IPPELA: 19216810, < I5—a—~K ’
@ 2005/01 724 2071:25 FE e
IPER: Hfo AR (R

K 5-13 IS—*vyt—o
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5.4.

BHEEEEIL., AX LV RTa o EBIAARTEIAL Y 7 A V% JTAG-Blazer DN AE Y (RER) ITMRFELE
T, WEL AT U OFEITH 16Mbit TTN, 274X alb—a T —XDEMIKHELTEBY, A€V
REEHEZD 7 7 A VOGEITIEEBINIEM S NET,

54.1.
I AT ~AERAT, 2 7 4 X2 —a v 77 A NEEFHLET, 20742 —a 774D
VERS HEIZ. MHgEB.av 7 4 X2 —3a v 77 A MERFIE] 28 LT E0,

5.4.2.
PC & JTAG-Blazer % LAN (2t LET, BEFO Ry MU —27 20 S TICHEBEER T 255813, 77X
HATOLAN 7 — 7 A2 FEH LT &N,

Bigith, 77— LUz TIERFLREETLTLEE N, ( 1510.7 7 — A7 = TREHFBR] 220 =5
— Lo TG EIE. BESERE TR TEE N,

5.4.3.

O JTAG-Blazer D IP 7 KL A& AN LET, IP 7 RLUAFREMFEKIZIP 7 RLAZ AN LT 7EE,

Q@ ar74Xal—rarZyrAVERIRLET, 77 AVDOBRIT, 77 A NVBIRRZ L2270 w7 L
T ANEERT LD, 77 A NVAREEIRICEIAT 7 7 A VORI SZAE AT, 2L, a7 4%
22— a7 ANVERNPOERL T EI N,

S o A Folb—var7r7A/E, SVF, XSVF, JSVF ##3H—k L“Cb‘?i\
;I'§‘ I, FNE svl, xsvl, Jsvf & WO HRRF4 THIBI S v, B LS OPRR T
IZOWTIX, SVF 77 A v & LT ENET,

@ NEAEVFALRI 27V v LET,

IPFELA | 192 188 10 1 | TG |G TAG-Blazer¥zamplesvi 1

Pogition | Device ID Device Mame k
0 00141093 HGAS400 ( S g )[,ﬁm;ﬁgp))
Time Event

5-14 REAERVEAHBEDI1VED
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@ FAHBMER T 4 FUBRF =T ENET, BRI A—ZPRELWI xR L, OK R¥ %7
Uy 7 LTLKEEN,

BAH ED X
IPFFLA 2192163101
ArroO—FAaq4s o JTAG-Blazer
el : sampleavi
gmET X : 212792 bytes
e B B e : Mo
5 il W : Mare

@ 30 A AR E T, LALL T 7

F+ 7l

K 5-15 HAEAEYEAHIERI1VED

® BEFA TR RA =T SNE T, R AT n7iE, FRALOERRENFRINET,
©® FARTE TR, XL A T 0 ZITHBNIC 7 n— AL £,

ERE(F0S 3

kA

5-16 BREA A 7045
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KT —0RELHE. A vE—URERIN, BERRERICT T —a— FRRRSNET,
HLVWTZI—HARIT, BRShicz I —a— % fF&C. =7 —U X ] TERLTSZS N,

,:__ JB Manager

FrLEY O RE

IPFELA | 192 168 10

FFua0) FTA AJTHH

Pozition | Device ID

Titne | Everl

) 2005/01/24 20:11:24 THA AU A ERR

IPPELA: 19216810, < I5—a—~K ’
@ 2005/01 724 2071:25 FE e
IPER: Hfo AR (R

K 5-17 IS—*vyt&—o
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5.5.
ABEREIL, JTAG-Blazer DN A EVIZRIFL TH D7 7 A V&, HEfiSN TS Z—F v hiR— F~&
AHET, ROEBERFALNPTE DHREL 0D 77,

5.5.1.
JTAG-Blazer & #—% v bAR— & LE T, [4.5JTAG r—7 VOB HE] 2L, B L T
<TEEW,

5.5.2.

O JTAG-Blazer DNEEAF ) ~EIALT-NWa L 7 4 FXalb—rvary77ANVERFELET, ( 15.4.HE A
£V EIAR] #SH)

@ START A# o % 1 LU EMTLET,

@ BUSY 7> 7S84 L, EALNBE L ET,

@ BUSY 77 {EAT L, EAALANKTLET,

M7 —2%AE L7-84A. ERROR 7 0 7035 L £ 37,
LW T —NEIL, BN X — % [+ D.ERROR 7 v 7RI/ RF—r ] TERL T EE,

JTAG-BLAZER
POWER
.. B O
: : BRROR

® )

B 5-18 START REVHIE
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5.6.
AMREIE, JTAG Blazer I[ZHHE SNV TN DX =5 MR— F EOTF A 2ERER R LES, ¥ =7 v b
R— R EITEBDOT N ARD55E1E, R RENET,

5.6.1.

PC & JTAG-Blazer # LAN (285t L £ 3, BEfFO Ry MU —27 20 S TICEEER T 258X, 712 A
2A4TFDLAN 7 —7LEFH L TL &, JTAG-Blazer & % —4 v FAR— Ri% [4.5JTAG r—7 D
B Al 22U, 8L T 7EE0,

5.6.2.
@ JTAG-Blazer D IP 7 FL A& AN LET, IP 7 FLAREFERIZIP 7 FLAZ AN LTSN,
@ M fEWRERR L 27 ) v LET,

PPFLA [192 788 10 1 . | I»fLs | =l

Fosition | Device ID Device Mame
Time Event

K 5-19 EAFERZREOVIIED
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@ WP T2&, K520 OXIIZT A AID BRRSNET,

,:__ JB Manager
el O RE AL FmAh ALTHH

& Joa): s ERIIEe

PPELA [192 168 10 1 [ ] oA | = .
Position | Device ID Device Mame

1] (=07 412093 35400
Titne Event

@ 2005/01.401 01:01:00 THA AUA FERRR
IPPE LA 192168101
i 2005/01 /01 0101 F&IN

K 5-20 #EEHRIMBEDOIIUEFD

KT —NRELIGE. Avt—YREmsh, BRI —a— FRERENET,
HLVWTZ I —HNET, RSz —a— e F&C.=7—J X b TERLTIEZS W,

5.6.3. ID
FRINDT A AD4L % JB Manager (288 U £ 3, DIBEOEAMIERIUSRFZIT, BELT7ZT 31 X
LMFERIND DI T,

O RINDAHEREK - BEELIEWT AL ZID %7V v 7 LET,

7:__ JB Manager
FrE O RE APL0 FTOAD AT

= fon) S ERUIRE

PPELZ [192 188 10 1 [ ]| Iwfla | = -
Pogition | Device ID Device Name

1] (07 41093 FE=
Titme Event

® 5-21 REBRT/N\AANKTE
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@ THAARZBPANTE LREBIZRD DT, BELIZWAKREZ AT LET,

,:._ JB Manager |Z||E|[Z|
FrILEY O REY AR Frld AdlIhid)

& Joa): s ERIIEe

PrELZ (192 168 10 1 [ | I | =] -
Position | Device ID Device Mame
D 001412093 AC3a400

Titne Event

522 FINAREZDESR

@ AR AIREHR, A=a—>T 7 A L>T AL R A NORGFEEFEITLET,

7:__ JB Manager

wea PN O FE A7 FJrh AJLTHE)
27 %R O

il

"

]
#TW

s oo ool ] DI‘?*{JL»% | ﬂJ

Pogition | Device ID Device Name
D07 47 2093 B

et ]

Titme Event

B 5-23 TINARAYRCDRE
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5.7.
AMEREIL, JTAG-Blazer DINITAE U ICIRIE SN TWD T 7 A MEBRERR LET, BRENDINAIL.
T AN ARG A R BEEAR, 7 ANV, AT a v e 0, ISR ET L E T,
%+ 5-24 WNEAEVER ZRREA—E

IHH B
77 A N4 RESNTWAa Ly 74 Xal—arTF—2D7 7 A 1LV4
RAEH A X REENTVWEa Ly 74 Fal—arTF—FP A4 X
HRk H B AT S U7 HIRE
7 7 A IVIERE RIFEINTWD 7 7 A )V OJEHEIRRE
F7a v RBIESNTWA Ty A NVICEREINT-A T 3 v

5.7.1.
PC & JTAG-Blazer % LAN (28t LE 7, BEfFO Ry NU—7 2N S TIWCHEBEEG T 25813, 70X
247D LAN 7 —7 VAR L T &0,

Hefgitk, 77— LU = TIEREREZFATLTLES Y, ([5.10.7 7 —2 U = TERKR] 22H) =7
—E oG AE, MESEN e THEES T2 S,

5.7.2.
@O JTAG-Blazer ®IP 7 L Z2Z A LEd, IPT7 RUAREERIZIP T RLAZATILTL &N,
@ WNEHAFEVIERFTRAZ 27 v 7 LET,

(=3

FD AJLTHH

774 i

Ei ,a-'f"} =% Y

1 .JB g *I—‘ : . :_.-_.': E

PrELZ [192 188 10 1 .| Ieflg | =] -
Position | Device ID Device Mame

Time Event

K 5-25 MHNEAEVEBRERREFDOIIED
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@ WMEREHTHE, K526 DEHICT 7 A /MVERBFERINET,

F74 )1 15 58 x|
el : sampleav

(R4 Z L 212702 bytes

=g 2 2005401 /01 000007

- I EfE : Mo

i P WA £ : Mane

K 5-26 J7AMIVEREBTRI1VFD

KET—=NRELTEE, A vE—VURFERIN, BECTT —a— FRRRSNET,
HLVWT I —NAI, RSNz TI—a—F%x (Mg C.=F—U X ] TBRLTIESD

o
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5.8.
ARgEEIX, SVF 7 7 A V% JSVF 7 7 A MZE# L %9, JSVF 7 7 A id, SVF 77 A V& 3AF
EHLI=7 7 ANVTSVF 77 A VEIEE L TH v u— R4 5 L0 bIEERHEEMHT2 2 LS TRETT,

5.8.1.
O A=ma—>avwr R>T7 7 A NVEBREBRINLET,

7-:,_ JB Manager

FrAILE) BRI AT FmO AJLTHHD

A—fubEAH T CtrT
fJE FIEEATUEARDY Ctrl+D
= i F TS Ctr+s

IPFELZ 2 M2 | ﬂ
Position 7 WEERF TR Gtrl+F l—I
JTAGHO»RERTE )
R EE R
Time Event

B 5-27 J7AINERDILED

Q@ TZrFANEWE AL T ol NERINET,
® ANJZ77A41 (SVF) N7 7 41 (JSVF) AL, OKARZ %2270 v 7 LET,

J7 A0 EBE 7O [X]

AT L EYE |O:¥JTHG—BIazer¥sample.svf
HA T LSYED |C:¥JTHG—BIazer¥sample.jsvf

el

K 5-28 J7AILEBRFT(F7OT

@ EFICEBPETTLE, R520 L H9ICA v E—UNERENET,

JB Manaeer

e LERIZPINLELE

X 5-29 ZEMET AvtE—D
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5.9.JTAG

AHEEEIX, #—7 v bR =R EOT NS RACT =X 2Bk T 5 IJTAG D7 ay 7 2% ELET, 27 4
Xl —va NRT AR, F203, a7 4 Fa2b—va U EAEBIC LW SR L £, A%
A TR L &L it 22 —7 Y FAR—RIZET 2 JTAG O 7 v v 7 & ZHERO ESHHAL 72
X,

5.9.1.

PC & JTAG-Blazer # LAN (28t L £3, BEfFOR Y MU —27 20 STICEEEGT 2561, 7124
247D LAN 7 —7 Va2 L T &0,

Hefgitk, 77— LU = TIEREREZFATLTLES Y, ([510.7 7 —2 U = TERKR] 22H) =7
— e oG AE, MESEN e THEES IS,

5.9.2.

@O JTAG-Blazer ®IP 7 FL Z2Z A LEd, IPT7 RUAREERIZCIP T RLAZ AT LTL &N,
@ JTAG 7 v VRERE %7 v 7 LET,

Y-u._ JB Manager

Ir{ILE YIRERY: AJLFHD
TEETE

) =R/
FPELA [192 1688 100 1 .| ZrlE | =1 -]
Fosition | Device ID Device Mame
Time Event

K 5-30 JTAG YOvIREEREDDI4FD
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JTAG-BLAZER

@ JTAG 7 my VREV 4~ RUNA—T o ENET, JTAG 7 1 v ZITRIE SR, BUEOBRENM

<,

JTAGHT 4 (kHe ) 4 3226005 ~ | JTAGZ 7 kHe } [ 322500 ~
S TZ00000

1612450
806.25
403113
201.56

B 5-31 JTAG Z/OvI8BEYI14VRY

@ REMEZERLET, 2R Ry 7 AXOVRELTLWVEZERL, OKAKZ 27 Y v 7 LET,

REMWZRAFT D722 27/ BUSY 4?(%75);’?7%%\

sy OKRZ L&Y s Lk,
SEE 5. oM JTAG Blazer OBRAIS R0k D SHEL £V, EHRAL
NG, RAFT— 2 S NG TR B 0 £
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5.10.
AEEREIX, JTAG-Blazer D7 7 — 27 = TR AEFR R LET, EIZ, 77— 0T OFEHEFMEH L F
‘a—o

5.10.1.
PC & JTAG-Blazer & LAN [Z#fi L £ 37, BEFOF v MU —7 20 STICEEERT 25613, 7 v 2
HZATDLAN =7 NV ZA L TS,

5.10.2.
O A=a—>F7var>77—AU=THEREENLET,

7.:,_ JB Manager

FrIAE O FE Rk Fnl)  AJLTHH

' X, TETT20E— L
pq LB

Jr— LT PIEERE

Pogition | Device ID Device Mame
Time Event

K 5-32 J7—LVIT7RBRTREDOIIERD

@ N—valFRFRY 4 RURE =T ENET,
® 77— =T IEREMRE, OKRZ %227 w7 LTLIEEN,

Product Version : w0102
Firmware Version : v01.02 { Jan 1 2005

B 5-33 N—DIAERRTVIVED
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5.11.
AR, 77— LU =T OEHFEITRVET, FHERIZ. Web 1 FETIHER 0,

5.11.1.
PC & JTAG-Blazer % LAN [Z#i#t LE T, BEFOR Y MU —7 20 S TICHEHEER T 25813, 72 A
HATOLAN 7 — 72 FEH LT &N,

5.11.2.
DO A=ma—2>FFvar>77yr—A7 =T BHFE2ERLET,

7-.__ JB Manager
P O RED FT0L AJFH

' / TETT20E—FiL)
Y- I

Ir=LIIT P EERED

PPELA [192 163 e 5 | =]
Pogition | Device ID Device Mame
Titme Event

B 5-34 J7—LIIT7EHFEHOI4URD

@ TZrANBREXA TR RDA—T L ENET, 77 ANERBIRL S AZ %227 U v 7 LTLEEW,
@ 77 —LU=TEHFHERT 4 RUNAE—T 2 ENET, FHATA—ZNELNT EE2fEEL, OK
REETY 7 LTLTEEN,

Fr— LT EH x|

IPFELA 192168101
Al bimage w0102 b

JTAG-Blazert) T — LI PEEMLE T,
A T 4 5% TR, JTAG-Blazerl)

EEF ST FAL
Ftm)

5-35 J7—LUIT7EHER IR
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@ BEFATRITPRFRENE T, BRL AT 0 7id, FALOEBRINFRINET,

R0 X

Firse

5-36 EREA A 704

® FAHRGTE TR, BEAA T JIZHBRNIC o — XL E7,
©® JTAG-Blazer (ZH#EMICY 77— FLET,

g LA A 7T a I RERREINTWARIL.JTAG-Blazer DEIRZH) 57220019 f‘?j{\
;I'§‘ BLTEEW, H—, BERPIZEERN ONT-5E6. 77— U = TIZRE DI

AL, =7y P ERABFEOMERTERRDWTEENRDHY £, £ X7k
BRNEELIZGE, BEY 7 =AU =T OEFH2TR-> TIEEN,
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5.12.
AEEREIL., 22— W — A L ¥ 7 = — ADBREF REREZ N E L T,

5.12.1.
O BREEERZ 220 v LET,
@ EEEHRPHESNET,

EOX

1,-I:__ JB Manager
( BEEER2Y )

7AMD TFD ATVL0 e

& falis

FPrELR (182 168 10 1 | FefaE | =] -]

Position | Device ID Device Mame
Time Evvent

5-37 BEHERV1FY
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5.13.TE7720

AEgEEEIZ,. TET720 SAA 252 a7 4 FXal—arvdAhEd0Fr 7 arOREFIEE LY 14,

TE7720 USDT A ZA TR, KA T a 2R ELRZVWEI>BEWNLET,
TE7720 (K=l 7 ra a0 28) 13, IWH7 T v 2 AF Y 2 LT Xilinx £ FPGA = 7
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6.

AL, JTAG-Blazer X IEFICEME L2 WGAESC, ©T7 — X v —UNRFRINTZHE OMGRHEIHZ L
LTWET, HEIZSLTEHALTZE,

Q. JTAG-Blazer SR TE 2\,
A. JTAG-Blazer ®EJFEN ON (22> TWAN TR &0,
Uo7 PRI L TWAEN TR &N,
JTAG-Blazer & PC ORI/ —Z DN 2 L & TR 2 &0,
Q. JTAG-Blazer Z#f/ET&E 72\,
A. JTAG-Blazer ®EJFEN ON (T2 > TWAN TR P &0,
Uo7 FREIT L TWANTRERLIIFE 0N,
JTAG-Blazer D IP 7 FL ANE L HREINTWNEINTHER L 1280,
JTAG

Q. BRABMNTERU,

A. JTAG-Blazer ®EJFEN ON (T2 > TWAN TR P &0,
JTAG 77— 7 VO & TR 7280,
AT A4 X2 L= a T ANANE LER SN ZHER L 1280,
2=y RAR— ROE ON 1272 5> T AN TR S0,

. BRABDBET LIZRB, =7y bR— FREFEIZEIEL 22V,
LAy I 4 X al—ar 7 ANADBIE LLIERENTTHERLS FE R,
FIALIEFIZ, IELLS AT a UBRRESNTEZD IR TZE 0,

> O

JB Manager

Q. THRARELD “RER” LR REIND,

A, REERT NA ADOAREMENR D £7, 15.6.83.7 /34 2 ID ORE - BE] #HUBHKL T2
S,
JBManager.exe &Rl U7 « L7 U IZ jb_device_list.dat 73&% % 2> ZHEFR < 72 &0y,

Q. BEETCIT, “TAL XY R M7 7 AV (jb_device_list.dat) BAEELERHA” LFXRENB,

A, THALAVARNTZ 7 A NVEA A R—/LLTLEE, (14.8.JBManager DA A h—)V]| %
ZH)
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A.
JTAG-Blazer
“HE 1 80W X 56D X 28H (mm)  (ZEEEHZFRL)
R % 200g
i HEREE 0 ~ 40C (fEEexz L)
TR DC5V 0.4A
Ethernet 10Base-T / 100Base-TX
LED A > U —X POWER. BUSY. ERROR
AA v F START R % o
JTAG 7 7 v 7 A 12.9MHz (Z ¥ mlgE

N AED 247

7Ty aXEY

a7 4 X2 b —va T — AR E

#) 16Mbit

a7 4 X alb—va a7 7 A VER

SVF (Serial Vector Format)
XSVF (Xilinx Serial Vector Format)
JSVF (JTAG-Blazer Serial Vector Format)

AR — M &=

TCP : 39293, 39793

73 A AJE

1.8V ~ 5V

KETET S A A

@Xilinx

Spartan IVIIE U — X
Spartan3 > —X

Virtex-II +V —X

Virtex-II Pro vV — X
XC9500 v U —X
CoolRunner XPLA3 ~ ) —X
CoolRunner-II U — X
XC18V v —X

XCF VU —X

@Altera

Stratix ¥ U —X

Stratix GX ' J —X
Cyclone >V —X
APEXII v U —X

APEX 20K/20KE vV —X
Mercury vV —X

FLEX 10K/10KE > U — X
FLEX 6000 'V —X
ACEX 1K v U —X

MAX 70008 U —X
MAX 7000A ~VJ —X
MAX 7000B v J — X
MAX 3000A >V —X
EPC >V —X

@l Y hurFNA R
TE7720
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JTAG
Symbol Parameter Min Max Unit Conditions
Vce Target Voltage 1.8 5 \Y
All Output pin = 4.7k Q
Icc Internal Use Current 6 mA | External Pullup
All Vo=VoL
1.17 V | VCC=1.8V
. . 1.7 V | VCC=2.5V
VIH High-level input voltage 5 vV [VCC=3 3V
3.5 V | VCC=5V
0.63 V | VCC=1.8V
i . 0.7 V | VCC=2.5V
ViIL Low-level input voltage 0.8 vV [VCC=33V
1.5 V | VCC=5V
i IoH=-100uA,VI=VIH,
vee0.1 V' | Veo=1.8V to 4.5V
IoH=-2mA,VI=VIH,
1.25 v Vce=1.8V
- IoH=-4mA,VI=VIH,
VoH High-level output voltage 1.75 A% Voe=2.3V
IoH=-12mA,VI=VIH,
2.15 \Y% Voc=3V
IoH=-16mA,VI=VIH,
3.3 v Vce=4.5V
0.1 v IoH=-100uA,VI=VIL,
) Vce=1.8V to 4.5V
ToH=-2mA,VI=VIL,
0.5 v Vce=1.8V
i ToH=-4mA,VI=VIL,
VoL Low-level output voltage 0.45 A\ Voe=2 3V
ToH=-8mA,VI=VIL,
0.8 v Vce=3V
IoH=-16mA,VI=VIL,
1.05 v Vce=4.5V
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B.

JTAG-Blazer (%, =7 4 ¥ a2 L — 3 7 7 A /L2 SVF, XSVF, JSVF Z i /f] L £, A& Tl Xilinx
iIMPACT %] L7z SVF, XSVF O{Epk51E%, £ 7z Altera Quartus IT Z M L7z SVF OER T % i
HLET, JELWERTGIEZ, BEVOY —AOv=a 7 VEE2 ZRHTZEN,

ARK~==7 /L TlE, Xilinx ® BIT, MCS, JED 7 7 A V%% KO Altera ® POF, SOF 7 7 A V%%
THAL T ANVERRLET,

B-1.Xilinx IMPACT SVF XSVF

@O iMPACT E#h L E 5,
@ “Prepare Configuration Files” Z#&RL R~ #27VU v 7 LET,

Dperation Mode Selection

What do wou want to dao first?

™ Configure Devices

* Prepare Confieuration Files:
" Load Configuration File {cdf, pdr)

TR AL

B B-1 Operation Mode Selection 91K
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@ “Boundary-Scan File” Z&RL [k~ 227V v 27 LET,

Prepare Contiguration Files

[ want to create a:

(" Svstem ACE File
" PROM File

<Fe® [ oy | #eta | AL

B-2 Prepare Configuration Files #IR™1 K9
@ ERT 277 ANEXERIRL [T 227Uy 27 LET, ZOHITIE, XSVF ZEIRLTWET,
Prepare Boundary—5can Files =

[ want to create a
" SWF File
(" STAPL File

<Fpe [ ®T | weta | AL

B-3 Prepare Boundary—Scan Files 3#iRro1> K
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@ fEkT a7 ¥alb—var7 A g, KO, RETDL 73V ERELET,

Create a Hew XSYF File EE

{RFIEIBHMD: | wavf -] cf B

I LA N |zample] R7F05) |
IrAILDIERRT: [ HSWF Files(hosvf) =] A7)

€ B-4 Create a New XSVF File #4704

® T[OKJ #7 Vv Z7 LET,

File Generation Mode [5_(|

&1l device operations will be directed to the file:
Ci¥wavi¥zamplesgwf

Click OF to start adding devices.

B B-5 File Generation Mode "9/ K™

©® THYA 77 ANEERLET,
FORA ZNZKTDTFA 7 7 A NDIBEFIZULTO L 91270 £17,
CPLD O#H4 = * jed
FPGA D35 = * .bit
PROM D54 = *.mcs

Add Device
TP DIBRRD: | xevf - cF B

CE

te7720.m

m| jed

chvp-‘-Lbit
xc3e400bit

%29572 jed
*cfld.mes

274 I [zc2c256 jed Fi 0 |
IrULDAEERT: |4l Desien Files = Fi)l

K B-6 Add Device #4704
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@ WE ECRRENTET AN ZAZER (7 V7)) LET, A7V v 7 F23A=2—0 “Operation” 7>
5 “Program” Z iR L £,

B untitled [File Generation Model — iMPAGT
File Edit “iew Mode Operationz Output Help

DEed s =22 = BEIE = %N
System ACE | PROM Formatter SVF-STAPL-XSVF |

wc3s400
e 3s400. bit
TDO
INFO:MPACT:301 - '1": Added Device xc3s400 successfully. ~

GUI - Add one device.
GUIL --- Clearing screen...
Device #1 selected

Faor Help, press F1 File Generation Mode SWF-STAPL-RSWF HEWF

BJ B-7 SVF-STAPL-XSVF 942 K™

FTa v EERLET,

Program Options

Wirtex-II -
I -
I -

-

-

Cancel | Help |

B B-8 Program Option 91> F™
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©@  “Programming Succeeded” & FE/REi7zH, A ==—>0utput >XSVF (SVF) File>Stop Writing
to XSVF (SVF) File #3#IRL, 207 4 F 2L —v a7 7 A VOERIZET TT,

& yntitled [File Generation Model - iMPAGT
File  Edit View Mode COCperations Output Help

DM & =@ & BB E | = 5N
System ACE | PROM Formatter SYF-STAPL-XSVF |

DI

»c:3s400
wic 3z400. bit

Programming Succeeded

Command: svi2zsvf -d -fpga -rlen 1024 -1 Coxsvfizample_tempImpact svi -0 Coxsvf sample xev ”
INFO:MPACT:380 - '1"Checking done pin ....done.

'1": Programmed successfully.

PROGERESS_END - End Operation.

Elapsed time= 1 sec.

Command: svilxsvf -c -fpea -rlen 1024 - Clzsvisample templmpact svi -0 Clxsvisample xsvf

For Help, press F1 File Generation Mode SWF-STAPL-H5WF HaWE

B B-9 Programming Succeeded /K™
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B-2.Xilinx iMPACT SVF XSVF
—ODTNRAAZBEIRT 5L ZAETIEAL T 4 Fab—a T 7 A VOERERRTT,

O M EOT AL A RBIROWRAET, A7V vV F21d A =2 —>Edit>Add Device kY “Xilinx
Device” F721%. “Non-Xilinx Device” #7 U v 7 LE7,

& untitled [File Generation Mode]l - iMPAGT

File Edit Yiew Mode Operations Output Help
D& W CIEY Haln 5 2
System ACE | PROM Formatter SVF-STAPL-XSVF |

Right click device to select operations

ToTo eI
TDI STHILINK
we3s400
xe3s400. bit
m—
Command: svflxsvf -d -fpga -tlen 1024 -i C'zsvisample_tempImpact.svf -0 C:'xsvfisample xsvf -~

INFO:MPACT:380 - 'I":Checking done pin ... done.

'I": Proprammed successfully.

PROGRESS_END - End Operation.

Elapsed time= 2 sec.

Command: svflzsvf -¢ -fpga -rlen 1024 4 Clxsvizample templmpact svf -o Cozsviizample xsvf

For Help, press F1 File Generation Mode SWF-STAPL-HSVF HeWF

B-10 SVF-STAPL-XSVF 4Ky

@ Fx—YENTWDLT AL ADTHFA T 7 A VEBRIRLET,

Add Device EE
TrA WOIBRRD: [ xevi -] £ EF-
te'."'."ED.mu:s
xc2c266 jed
xc2vp4.bit
xc3e400bit
=) 00572 jed
xefld.mos
7 M [xctld mos Frie (0 |
FrILDFAEERD: | Al Desien Files =] F ATl

B-11 Add Device ¥4/ 7R%
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® PROM OFHA 77 ANEFERLEEAIZ. IB12 X34 —7r&nEd, avRARy 7 2ALDFA
A AL BRI LT E,

Helect Device Part Hame

Select PROM

Part Mame:

wol8v0d_podd
wc] 804 wgdd
woflds woX0

xf08p_f=dd
xcfl8p_wodd

QK _|xctiBpisda e |

xcf16p_wodd

xcf32p_f=48
xcfddp wodd

B-12 Select Device Part Name ¥4 7 A%

@ HEECHLWT AL ZRBMENET, S BICT S ZAZEBNT 55615, O»6RCFIEZERED K
LET,

& untitled [File Generation Model - iMPAGT
File  Edit Wiew Mode Operations OQutput Help

0@ W Y eI =5 K2
System ACE| PROM Formatter SVF-STAPL-XSVF| =y

Right click device to select operations

TDI g S ForILING
B Ei |untitled [File Generation Model — iMPAGT
D0 ) File Edit Yiew Mode Operations Output Help
(= = 2|5 - N oW
System ACE | PROM Formatter SVF-STAPL-XSVF |
Right click device to select operations -
##* BATCH CMD : setAttriby
"2 Loading file 'Cxsviizcfld.me
. YTy Ty Ty
GUI — Add one devics. TDI b {1 SonILing o RILINE
e Il priesss 71 #o3s400 Hoflds #o20256
we 32400 it wcf0d. rcs wodo2hE jed
DO
GUI — Cut 1 device(s).
Device #4 selected
*** BATCH CMD : deleteDevice -position 4
GUI — Bemoving device #4
GUI — Cut 1 devies(=).
w
For Help, press F1 File Generation Mode SWF-STAPL-HSVF HeWF

B B-13 SVF-STAPL-XSVF 94 K™
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® FRENTWVWDET AL AND, AT 4 FXalb—valTDHT 4 ZAERIRL, F7 Y v 7 FiidA=
= —@ “Operation” 75 “Program” %R L E T,

& untitled| [File Generation Model — iMPAGT
File Edit Yiew Mode Operations Output Help

DEHE =@y EEEE e G
System ACE | PROM Formatter SVF-STAPL-XSVF |

. amLINK E E

wc3s400 wcf0ds uc2cZhh
we 32400 it wcf0d. rcs wodo2hE jed

GUI — Removing device #4

GUI — Cut 1 device(s).

Device #1 zalected

Device #2 zelected

Device #3 selected (ctrl-key-down)
Selected device are: #1 #3

For Help, press F1 File Generation Mode SWF-STAPL-HSVF HeWF

B-14 SVF-ATAPL-XSVF 94K

® 7 arEBRLUET,

Program Options

|v Eraze Before Programming I

[w erify r

[~ Bead Protect

-

PROM

Wirtex-1I r

[ B

[ B

[~ PROM/CoolRunner-T Usercode 8 Hex Digits?

Cancel | Help ‘

B B-15 Program Option "7/~ Ky
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@

to XSVF (SVF)

& untitled [File Generation Model - iMPAGT
File  Edit Wiew Mode Operations Output Help

DEd s2@ 5 G B0 5N
System ACE | PROM Formatter S¥F-STAPL-XSVF |

“Programming Succeeded” & FE/RII72 5, A ==—>0utput>XSVF (SVF) File>Stop Writing
File’ 2@ L, a7 4 ¥al— a7 7 A VOMERIZRE T T,

TDI %}::’:ILIHE

w3z 00 HEVF
wc3s400. bit

Programming Succeeded

done

'3': Programming completed successfully.

Command: svi2xsvi -¢ -r 0 -extensions -i C:'zsvfisample chin tempImpact.svi -0 C:'zsviisample chin.xsvi
PROGRESS_END - End Operation.

Elapszed time= 12 sec.

Command: sviZxsvf -¢ -r 0 -extensions -1 C:'xsvfisample chin tempImpact.svi -o C:zsvfisample chin xsvi

Far Help. press F1 File Generation Made SYF-STHPL-X5WF HaWF

B B-16 Programming Succeeded "7/ K™
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B-3.Xilinx iIMPACT SVF XSVF
FNRAANF 2= ENTWNWEHLEED, [Aay 7 4 X2 b—3 g VARERNSNZ — 0 Z LU TFIORLET,
AT 4 X2 b—a T 7 ANVOERIZLL F8Z — 2 TER L TL 2 &0,
<D FPGA Z#[Flf=2 7 4 ¥ =2 L—3 3 VA[BETY, (Zd & & CPLD, PROM (F=> 7 ¢ %
2l — g TEFEHA)
- #%> CPLD X O PROM %Az 7 4 Xa L — g VAfETT, (ZD L X FPGA IZ=> 7
A F2l— g TExFEHAL)
- B TETT20 # A2 7 4 ¥ 2 L—2 a VAlfETY, (Zd& & FPGA, CPLD., PROM
X2y 7 4 Fa2l—ra U TEERAL)

FPGA DA T = — N TWHGE

: F T FPGA £7213, 7D FPGA % 7]
O O By 7 4 %o L— g L ARECT .

$_To» CPLD X' PROM F7-1%. 5
E£® CPLD X PROM Z[Flflca—
A F¥z2l— g  A[ETT,

T _TO FPGA 721X, f57ED FPGA % [d]
Brlcary 7 X2 l—32 g VA[fETY, 2
® & % CPLD & X0 PROM [Z[FIFfIC =
T A4 X2l —arTExERA,

9_To» CPLD 1 XU PROM F721%, 5
ED CPLD X O PROM # [l 7
4 F¥=2lb—vaA[ETT, ZTDLX
FPGA IZ[FIca 7 4 Fal— g T
EH A,

TE7720 & EOMOT S ART == ST DTS + o TET720 £7-1%. $ED TET720
PRIy 7 X2 —32 g VAERET

g 5 / XILINX 5 £ XILINX &
S thon (OIS s TP = TP i T ZOLXTOMOT AL RLFABIC =
PROM PRO

V74X 2l — g TEET A
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B-4.Altera Quartus Il SVF

@O Quartus IT Z&E#E L F 3,
@ A==—» b Tools>Programmer % &R L, Programmer % fL#) L £,

W Chainl.cdf DX
£ Hardware Setup_ BiyteBlaster [LPT1] Mode: |JTAG ~| Progress: 0%
File Device |Eheck$um Usercode ELDH%ELT; Werify Eﬁ:ﬁk Examine SBEE:"GI | Erase CILS-'!E
el Aute Detect
(2 Add File...
(2 Add Device...

B B-17 Programmer #)&iEm®E

@ AddFilezZ7 Vw7 L, VA 77 A VEBMLET,

Select Programmme File

s B | ) =ample ﬂ &= e E8-

@ eplc.zof
= epits.z0i
@k gof
@ epmapof

e i |e2ik. 0t i 101 |
FrAIDAERT:  [Proeramming Files Msof#*poljam#bekjicd = | ol |

X B-18 Select Programming File
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@ A ==—M»05 File>Create/Update >Create JAM, SVF, or ISC File Z R L £,

i Chainl.cdf =13
;; Hardware Setup... ByteBlaster [LPT1] fode: |JT,€_\|3 ﬂ Progress: 0%
File Device |Checksum ‘Usercode ‘ E[DDH%ELT; Werify | E:'?:clzik E xamine Segﬁlity | Eraze CIEE
WA dsample.. EP20K200EF484 OO03EBZ27 FFFFFFFF (] (] [} O O |
ﬂ]ﬂ Auto Detect
2 2dd File.
(2 Add Device...

B-19 Add File £ D&M

® RSNV RUICUTOEAZANL, OKARZ %7 ) v 7 LET,

File name AEREILD SVGE DO 7 7 A V4
File format : Serial Vector Format (.svf)
Operation : Program
Clock frequency : 1.0MHz
Supply voltage TS, ADOUAEEE
File name; [ samplessample svf J
File fesmal |Seﬁa|"."ectn' Faomrnal [.sf] |
Op=ration Programming cpbions
* Program [ Blank-check
i Wenfy =
Clack fiequency
0K frequency: [1.0MHz
Supply vokage: |33 vilts j

B B-20 Create JAM, SVF, or ISC File
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C.
a—RK Iyt—o ZHE
OXFFFF0001 | 7 7 A A —T L I2 KkIiK AN LT T 7 A VA BHAFEL 720
OxFFFF0002 | 7 7 A /L i AriA A ZRHL MoOT 7V r—va TT7AAREREN TN D,
OxFFFFO003 | #skZ& % v &L Xy LFELE,
. ESEN
OXFFFFOO1T | Bfsiic el fg‘;ﬂ%ﬁ?%?fm AnTense.
OxFFFF0012 FL G Hafoe D B I,
OxFFFF0013 T —H A IR JTAG-Blazer 76 D5 — X A3 2R
OxFFFFOO014 T —Z EEIT R JTAG-Blazer ~D T — ¥ FE(F TR,
OXFFFF0021 | 7 7 A /LHf A XA —"— BIRLIE7 7 A VOFA ADKRETE B,
OxFFFF0023 N2 E G JTAG-Blazer O/~ 77 w7,
OxFFFF0024 | N—T g U R—E JB Manager., 7 7 — AU = 7 BNEHT TIE7R U,
0x0000FFFE 7 hann—y g VR JB Manager, 7 7 —A U = 7 NEH TIE720,
0x0000FFFF | TN = JTAG-Blazer 73MtL oD B3Rk 2 LB H
. a7 4 FXal—a T AANEE,
0x00010002 T =R R—E TE7720 473 5 VA E,
0x00010003 FT—HF v 7K AT A4 X2 b—a Ty AV,
0x00010004 | KxtfSD 2~ > KA ER A T4 X2 L—a T 7 AV
0x00010005 AT — N DB W a7 4 FXalb—a T AV EE,
0x00010007 | BUSY %=1 k%A A7 % I ;g;g;;;9;;££f4”%£ °
B = MR — RISEEGE STV,
0x00010008 & —77 N AR H—27y AR — ROEIRNB AT TR,
JTAG 77— 7 /UHIE L < #:6 AL TV,
B —0y MAR— R S LTV,
0x0003000A =77y NTNA AR H—7y R — ROBEIRB AT TR0,
JTAG 77— 7 L3 E L < BEGE I AL TUNVR Y,
0x0001000D
0x00020020 T — & B REL LAN 77— 7 )V 33k S AU TUN a0,
0x00040003
0x00010105
0x00020021 AT Y MR IR JTAG-Blazer 23N> 77 v 7,
0x00080004
0x00040011 Ta g T AT — A By Tr7ANT F—~v FBIELLIRW,
- - =
x%x%% I — ﬂ?Gmma@Wﬁf%)kT B REIAE N T
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D.ERROR
RE/INE—> IS—EHR

ON F—EF oI — (2Q¥EH)
NEB A VIZEAENTZ T 7 A LA
Wear E20%, =Ty T AL R

OFF ATIEH EHA,

ON TARGET x5 (0.2 #EH)
B—F sy bR— KBRS LT E
FA, £720%. JTAG r—7 LDz

OFF ot s B H

ON T ANVEE
JTAG-Blazer ONHEAE VT T 7
ANPREESIL TR, 774

OFF LB TV D,

ON BUSY

W W JTAG-Blazer 7M1 0> Bk 4 fL s,

OFF
JTAG-Blazer OREEHIZIHB L TV
FT, VAU T DEFEITR

OFF STLFEEN,

ON /\/\/\ Z DAt

OFF
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14

10

E.JTAG

14

i
dJjn

BS54

GND

VCC

GND

TMS

GND

TCK

GND

[ |OT | [N |

TDO

GND

TDI

GND

NC

GND

NC

6

BS54

NSr—TJILERF

=
Hho—

TCK

TCK

GND

GND

18|

TDO

TDO

L&
[V

VCC

VCC

b

TMS

TMS

2

NC

NC

NC

NeRNooRIEN JNepl N I NUVE N NN i

TDI

r

—
e}

GND
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F.ITAG
14
AN E A—h—
SMT # A4 7 A L — |k 87832-1420 MOLEX
AN =K== H AT XKL — | 87831-1420 MOLEX
AN—TR—=NEAT T NT T 87833-1420 MOLEX
10
20N BE A—H—
2.54mm ¥y F Ry 7 A¥ AT A L—h10 B 103308-1 AMP
20N BE A—H—
2.54mm B F Ry 7 AH AT A RL—k 10 B2 103308-1 AMP
omm EvF Ry s AXALF ARL—Fh 14 87831-1420 MOLEX
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G.

Z =0y MERZBRGFFSNDEIE, FOZ EICER LTI ZE,

c FWR ED JTAG 27 X L2 —Fy hT AL ZDOFEENEWGAC, To—r L TWnHH—
Ty NT A A OEBEREWGS, A RAORBEEZ TR hole b FHEBIES Y 1 A
=7 ¥R EDFRICRY £9, Ho JTAG 555 1 i, 253 LT<
728w, £72. GND 7L — v % FoZBEMKOMERL, JTAGE S0 T R — 2k
HH— Rldfp7e E2BEID LET,

- JTAG 155 ® TMS, TCK X, #—% v b7 31 2izxt LIL@EDIE S T9, TMS, TCK =%
S DE—5 'y NTNA ATWHNIET D L. AN TRENEMLET, F2EFT7 14 b
KRINZEL o TLEWVET, 20D, /A RAOEEEZITOT o720 | FEEBIESLY
A =7 KHREODRRERYET, ¥—F v b T AL ADF = —0F, &K 5 HET
L, ZNLLEIIANY 77 ZFHAL T EE, HERD JTAG 5571 i3 b~ <A
LT ZEW,

- JTAG =27 ZICANT 2 VCCEEIZ, #—5 > T4 AD VCCEELFTIZL T
SV,

B JTAG EEOTNT v 7H,EE, ¥—7 v b T34 ADVCC LEICEEIZL T EEW,
ARBEF —T y FT AL ZAORARC, @M 7 4 X2 b—2a OEBDOS, B ED
JTAG 227 X314 7T v Nr—TNVHarx s ZOFEEZBHO LFET , 47Ty

Fr—7nE, & JTAG EEEIICENENT T 2 FRDBERESNTEYD . /A A0
FIZKL, Fezv X b= R EEMilcE 7,
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H.JB Manager for Linux

Linux 7] @ JB Manager {22\ Tt L £ 97,

JB Manager for Linux
JB Manager for Linux ® A > A b — /L FlEZ LI FIZR LET,

O JB Manager for Linux A > A b —/L 3% PC 2, AHLIZfHE SN TS CD 2 AL ET,
@CD RIAT7TH~T L NLET,

@ DRIVE/Application/JBManagerLinux.tar.gz # 2 — /L N7 4 7 ~ab—L £,
@ “tar zxvf JBManagerLinux.tar.gz” CH#HE L £ 77,

XDRIVE (3"/mnt"D X 51~ T ML LZITHRELLET A L7 FUARRERD T,

L EC.JB Manager for Linux O > A h—/LF5E T CI M L TTEX7=7 4 L7 hVIZEHEI L, make

g~y REFTTHEa v AL TEET,

avokR HaE
ibtarget Ry FUﬁﬁﬁ’éEﬁfﬁ—/f“/ FAR— R~FIALE T,
a7 4 Xal— a7y AE, XSVF 22 JSVF #45E L £7,
AL KT v FARRIEIAL 7 7 A V% JTAG-Blazer DN A E U ~3E
jbflash IAHET,
a7 4 Xal—var 7y AE, XSVF 22 JSVF Z45E L £7,
. - JTAG-Blazer [ZHft SN TWAH X —57 >y AR — K EOT A RFRERRL
jbdevicelist F4
jbfiledata JTAG-Blazer DWW A E VIZRAFSNTND 7 7 A VDO REER T LET,
jbgetspeed 2=y hIR— RFABLEATIRORED, JTAG D7 vy 7 2 FRKRLUET,
jbsetspeed 2=y hIR— RFIABLEATIROKED, JTAG D7 v v 7 2 E LET,
jbversion JTAG-Blazer D7 7 — L7 = TIHERAFRLET,
jbprogsize JTAG-Blazer 7 7 — AW = THEIBKY A4 A& Fm LFET,
jbprogupdate | JTAG-Blazer 7 7 — A7 = 7 % HH L 7,
jbdatasize AT 4 X2 b—ra T — AR A XA R LUET,
jbcomp a7 44X alb—varyT—HEEMLET,
jbdiscover JTAG-Blazer Z & L £7,
jbipconfig JTAG-Blazer D IP 7 RL X Zg%E LE T,
svf2jsvf SVF 7 7 A )V % JSVF 7 7 A VA L3

KETCOaAw U NiE, A7 3102 h 2RETHENNTRERRENET,
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JB Manager for Linux %A > A h— L L7z A WL T 4 L7 RUICNE AT Y EALY T VA 7 Y 7 |
(FlashWrite.sh) 234 VA h—nLENET, ZOARAZ VS N2FTTHLE04 7 a 2L TIRLE

7
AFoay B
41 [IP 7 FL=z] JTAG-Blazer ® IP 7 KL A& EE L £,
flar74F¥al—var7ZryAn] | a7 4Fal—ar7rALEEELET,
-1 TE7720 €— K& ELET,
-L TE7720 €— R&$5E L EH A,
-h VT NFERSNET,

5. FlashWrite.sh -1 192.168.x.x -f sample.xsvf -L

JB Manager for Linux # 4 > A b=V LIzA LT 4 V7 N7 7 —A 0 =T HEHFF TR YT
k (FirmUpdate.sh) 31 VA h—LENFT, CORZ VT " 2F 750 &04T v a v HZUTIORLET,

AFvay Bt
41 [IP 7 KL A] JTAG-Blazer ® IP 7 KLV AZEEL 7,
A7 57— 2T 77 A)] T =AU T 77 ANVERELET,
-h VT INFERINET,

f5l. FirmUpdate.sh -1 192.168.x.x -f jb_image.jb
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Ver. £ AAH BETAHAR
1.0.0 2004/09/01 - WIRRAERK
1.0.1 2004/09/17 - [5.2.1.XSVF 7 7 A )LD Y] 1[2BW T, EEXXEZ BN

- [5.3.1.XSVF 7 7 A VDO ¥ 2BV T, HEEXEBMN

- 8k FIJTAG 7r—7 vt a k7 4 —% ) (IZBW T, KIEM = x 7
i ZR A BN

- CPLD OfRF%#{&1E

1.0.2 2004/10/04 « [{§% H.JB Manager for Linux] % B0

- MTAT T DI (A BN

- TfFek ABLELERR ) 1B W T, SIS T A A EEIE

- [4.3.) OFEHEEEE

1.0.3 2004/12/07 | - gk G2 —4 v MEMGEE EOBEES) 1BV T, T v R
XA —2% GND 7' L— I EIE
- DA R A EE

1.1.0 2005/01/28 | « HN—T 3 ZxIET DT, AR AEE - BN
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ARBZEENDN— R Y =7 A% 1 FRICET O THERICBWTRE L7256, 2k
PRAE L E 7, S I RFEE 2 IR A T B E W BT OBRGEMRBEE £ 7213/ EIEICIRAI L T 7ZE W,
HEIC TRV LET, Zde, BEULEAHIHE D RN, 20 E/RML SE TV RIEE ET,

Tl LRGEHIMN TH - Th ., Fil, 2. B, BEIRICX > TR LIZHE. AL 2D
ZENTEVET, HOENTODIT TR TEIVY,

PRAEBIFR IS, 0 — il L7281, RAEEORREARICE S SR T I — A 2TV ET,
THEAZRIT, RAEEORRWFEHZ L BRALTESVY,

PRAEF I, W ORFEHIF ZFEH 42 O T, BRW EJFHEA B IRFEEAICRRA A2
INZHEB S T28 W, TG DORMHEN L WEEIE, REEHIRIAN TH > TH, REESIFA & 380 bivia
WZERHY ET, WHONDRH-T2HEIE, BHORDWIZIEWIERFEEE TR LHTIZS
Wy PREEEIIRENIARE LTS ZE W, RAEHIR, SREEFHICOW T, RiEEZ ZR S0,

LITICHHERES O U A M2 fifll L4, BRESETIEMICANRWIREBICR D £ L6 Fihd b
DEZHL TS TZE N,

CBEUNT =T

- UWErT7Ty =T

- 107 Ty =T

AR OV TEMMRI 2B, 23R 07T v 77 v — FIZBET 2 ZTEMIE, BEW EFOKR
EREE, /NEIE £ TBHWEDES SN,
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